EPSON VTG6L Startup Guide
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Chapter 1. Overview
This guide helps you set up your EPSON robot to work with ForgeOS 5.

You will complete these steps:

. Check for the requirements.

. Connect all the devices and power on.

. Set up Forge/OS.

. Transfer Forge/OS robot configuration files to the robot.
. Configure the robot in RC+ and Forge/OS.

oo O B~ W N -

. Program your robot with Forge/OS!

Note:

This guide assumes that you have installed the robot following EPSON instructions.

Important:

Before you start programming, please read the Known Issues (on page 56) section. The robot may
behave unexpectedly when near a singularity. THESE ISSUES ARE NATIVE TO EPSON AND NOT AT THE
FAULT OF FORGE/OS.



Chapter 2. Hardware Requirements

Image Part Name Description Vendor Part Number
READY IPC Hosts Forge/OS. READY Robotics
- ™
Note:
READY offers two IPCs:
Forge/Hub and Forge/Ctrl
(legacy)
OR N
READY pendant | The touch screen interface for Forge/ | READY Robotics | 112563
OsS.
READY pendant | Connects the READY pendant to the |READY Robotics |R-101257

Junction Box

(Forgel/Ctrl only)

Forge/Ctrl and robot controller.

12-Pin M12 to Fly-
ing Leads Cable

Connects to the READY pendant
Junction Box or Forge/Hub to termi-

nals.

READY Robotics

Robot Controller | Connects the robot arm to power and | EPSON
to other devices.
USB A-Male to B- | Connects a Windows PC to the robot | EPSON

Male Cable

controller.

(Included with ro-
bot)
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Image Part Name Description Vendor Part Number
Windows PC Required to load Forge/OS configura-
tion files to the robot controller.
Emergency Termi- | Connects the robot controller to the EPSON RE000975-1

nal Block Kit (with
Cable)

READY pendant and safety devices.

24V/2.5A Power
Supply

Powers the READY pendant and other

devices.

Min./Max. current: 2.5/5.0 Amps.

e.g., Siemens
6EP1332-5BA00

Polycarbonate En-

closure or Cabinet

Protects the Terminal Block Kit and the

Power Supply in an enclosure.

Catbe Shielded McMaster-Carr 7734T6
Ethernet Cable » Connects the robot controller to
(X2) an IPC.
» Connects the READY pendant
to an IPC.
USB Flash Drive | Transfers Forge/OS configuration files | READY Robotics | R-400030

(with at least 2GB

of available mem-

ory)

to the robot controller..

(or other)




Chapter 3. Software Requirements

EPSON RC+ is the software that you use to communicate with the robot in its native language. Access to the full version

of RC+ came with the purchase of your robot. Install it on a Windows PC to load Forge/OS configuration files.

Note:

EPSON offers a free trial of RC+ for testing on a simulated robot. This free trial will NOT work for setting up
Forge/OS.

Important:
If you have built or loaded projects on the controller before, you may need to do a factory reset. Contact EPSON
Support for help.

Refer to the table below for the minimum required RC+, controller firmware, and Forge/OS versions.

Controller Minimum Software Version

VT6L RC+7.0,v7.5.2

Firmware v7.5.53.0

-
6 Tip:
Refer to Checking the Firmware Version (on page 6) for instructions on how to check your controller firmware

version.

N

Checking the Firmware Version

Follow these steps to check what firmware version your EPSON controller is on.
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1. Plug the robot controller's power cable into a power outlet. Follow EPSON documentation for powering it on.
2. Plug the USB Cable into the robot controller's PC port. Plug the other end into a Windows PC with EPSON RC+
installed.

3. Open EPSON RC+ in Program Mode.
o If you see the pop-up below, click Change To Program Mode before the 5 second countdown expires.
o If the default boot mode is set to Program Mode, wait for the 5 second countdown to expire.

4. If you set a password, enter it. Then click OK.
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5. If you see a pop-up about monitoring controller operation before Program Mode boots, click Yes. If you see it after

Program Mode boots, click No.

6. If you see a pop-up about starting another session, click Yes.

7. If you see a pop-up about current tasks running, select Stop all tasks.

8. In the top menu, select a Connection type of USB.

0 Tip:

The USB option is only available when:
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e o You are using the full version of RC+.
> Your USB cable is connected to the robot controller and Windows PC.

9. Go to Tools. Select Controller in the dropdown.
ﬁ EPSOM RC+ 7.5.0 - Project CA\EpsonRCT0NProjectshready-epson-driver\EPSOMN_DRIVER
File Edit “Wiew Project Bun | Tools | Setup Window Help

Cirl+M
Cirl+
Cirl+T

Cirl+L
Cirl+Ll

Ctrl+F5
GUI Builder Ctrl+F7
Conveyor Tracking Ctrl+F&

10. Click Backup Controller.
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11. Select the location where you would like to store your backup. Click OK.

12. Click View Controller Status.
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13. Select the backup file that you just created. Click OK.

14. Find the Firmware Version.
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15. Verify that your firmware version matches the requirement. If you need to upgrade, contact EPSON Support.



Chapter 4. Connecting the Robot Controller

1. Plug an Ethernet cable into the LAN port on the robot controller. Plug the other end into a LAN port on your IPC.

2. Plug one end of the EPSON Emergency Cable into the EMERGENCY port on the robot controller. Plug the other
end into the Terminal Block Kit.



Chapter 5. Connecting the READY pendant

The READY pendant includes these safety outputs:

1. Key Switch (Robot Operation Mode)
2. Three-Position Enabling Switch
3. Emergency Stop Button

Note:
For EPSON robots, you connect the READY pendant Emergency Stop, but not the Key Switch and Enabling

Switch. Always perform a risk assessment and use appropriate safeguards, like a safety fence.
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Electric Shock Warning: Disconnect all components from power sources before attempting
this installation.

1. If you are using a Forge/Ctrl, prepare the READY pendant Junction Box:

a. Connect a Cat5e STP Ethernet cable from the junction box Ethernet port (1) into a LAN port (5) on the
Forge/Ctrl.
b. Connect the 8-Pin power cable (4) from the junction box into one of the Module ports (6) on the Forge/Ctrl.
c. Connect the 12-Pin flying leads cable to the safety port (3) on the junction box.
2. If you are using a Forge/Hub, connect the 12-Pin flying leads cable to the Safety port on the Forge Hub.

3. Wire the 12-Pin M12 Cable's flying leads to the Terminal Block Kit:
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12-Pin Cable EPSON Emer- Function
gency Connector

Brown N/A Enabling Switch
Blue N/A Enabling Switch
White N/A Enabling Switch
Green N/A Enabling Switch
Pink Pin 1 Emergency Stop
Yellow Pin 9 Emergency Stop
Black Pin 10 Emergency Stop
Grey Pin 14 Emergency Stop
Red N/A Key Switch
Violet N/A Key Switch
Grey/Pink N/A Key Switch
Red/Blue N/A Key Switch

Pin2, 3 Jumper

Pin 15, 16 Jumper

Pin 4, 11 Jumper

Pin 12, 17 Jumper

4. Wire the safeguard device (e.g., safety fence) and latching system. You can wire a button or switch to the latch
release pins to control the latching mechanism. Or you can jumper the latch release inputs so the safeguard auto
resets when you close the fence (shown in the table below).
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EPSON External
Emergency | 24V Pow- Safeguard Device Function
Connector | er Supply
24V Safeguard Contact 11 Safeguard Input 1 Circuit
Pin7 Safeguard Contact 12 Safeguard Input 1 Circuit
Pin 8 ov Safeguard Input 1 Circuit
24V Safeguard Contact 21 Safeguard Input 2 Circuit
Pin 20 Safeguard Contact 22 Safeguard Input 2 Circuit
Pin 21 ov Safeguard Input 2 Circuit
Pin 18 24V Latch Release Input (Jumpered)
Pin 19 24V Latch Release Input (Jumpered)

-
6 Tip:

Refer to EPSON documentation for more information on safeguard wiring and pin assignments.
N /




Chapter 6. Powering On

1. Plug the robot controller's power cable into a power outlet.
2. Power on the robot controller.
3. Plug your IPC's power cable into a power outlet.



Chapter 7. Signing In to Forge/OS

Follow these steps to pair the READY pendant with the IPC and sign in to Forge/OS 5.

1. If you need to install Forge/OS 5 on your IPC, stop here and follow all the steps in Appendix A (on page 44),
then come back to these steps.

e Tip:

Forge/OS 5 is installed on all Forge/Ctrls and Forge/Hubs shipped after June 1, 2021.

2. The READY pendant automatically finds and pairs with the IPC. The three LEDs on the screen help you track the
status:
> Pendant Network Connection: This condition is satisfied when the READY pendant has a valid network
connection (i.e., the Ethernet cable is plugged in).

> Forge/OS IPC Detected: This condition is satisfied when the READY pendant detects a Forge/OS IPC on
the network.
> Forge/OS IPC Paired: This condition is satisfied when the READY pendant successfully pairs with the IPC.

If pairing fails, it is automatically retried indefinitely.

When a condition is not satisfied, the LED is red. When a condition is in progress of becoming satisfied, a spinner
around a READY logo appears to the right of the text. When a condition becomes satisfied, the LED turns green.

The Ul shows the real-time state of each step. For example, if the pendant loses its network connection during

pairing, all steps become undone.
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If the READY pendant spends more than 60 seconds on any step, troubleshooting text displays. Common things to
check are if the READY pendant network cable is plugged in, if the IPC is powered on, if the READY pendant and
IPC are connected to the same network, and if there's only one READY pendant and one IPC on that network.

3. Tap Admin and sign in. The default Admin password is "forgeadmin".

4. If Forge/OS is inactive, it opens the Settings app and prevents you from opening other apps. If you see the screen

below, follow Activating ForgeOS with a License Code (on page 57) in Appendix A.

5. With Forge/OS active, move on to the next section.



Chapter 8. Device Configuration - Pt.1

1. In the Admin role, open the Device Configuration app.

2. Tap New + to open the Device Library.

3. In the Device Library list, select EPSON industrial robot. Then tap NEXT.
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4. Select VT6L for the Controller Model. Fill in the other information later.
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5. Insert a USB flash drive into the IPC as instructed on the screen. Use an empty flash drive with at least 2GB of

storage.

e Tip:

Do not connect the USB flash drive to the READY pendant.

6. Tap Start Transfer and wait for it to finish.
7. Remove the USB flash drive when prompted.



Chapter 9. Importing the Project in RC+

1. Insert the USB flash drive (that has the configuration files from the IPC) into the Windows PC.
2. In File Explorer, go to your USB flash drive's storage. Open the forge-os folder.

3. In that forge-os folder, right-click the ready-epson-driver folder to copy it.

4. In your Windows (C:) drive, open the EpsonRC70 folder that was made when you installed the EPSON RC+

software.
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5. In that EpsonRC70 folder, open the projects folder.

6. In that projects folder, right-click to paste the ready-epson-driver folder that you copied.



EPSON VT6L Startup Guide | 9 - Importing the Project in RC+ | 26

7. Open RC+ in Program Mode.
o If you see the pop-up below, click Change To Program Mode before the 5 second countdown expires.
o If the default boot mode is set to Program Mode, wait for the 5 second countdown to expire.

8. If you set a password, enter it. Then click OK.

9. If you see a pop-up about monitoring controller operation before Program Mode boots, click Yes. If you see it after

Program Mode boots, click No.
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10. If you see a pop-up about starting another session, click Yes.

11. If you see a pop-up about current tasks running, select Stop all tasks.

12. In the menu bar across the top of EPSON RC+, open the Project tab. Click Import.

13. Set the import location as PC. Then click Next.
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14. Select a project type of EPSON RC+ 7.x. Select the copied "ready-epson-driver" project. Then click Next.

15. Type "EPSON_DRIVER" in the Destination Project Name field. Then click Next.
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16. Select the Open Destination Project After Import checkbox. Then click Import.



Chapter 10. Configuring the Robot

1. Expand the Connection dropdown in the top-right corner. Select USB to connect to your robot.

-
O o
The USB option is only available when:

> You are using the full version of RC+.
> Your USB cable is connected to the robot controller and Windows PC.

N

2. In the top menu bar, select Setup. Go into System Configuration.

3. The Startup menu automatically appears. If Auto mode is not already selected, select it and click Apply.
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4. In the Controller menu, select Configuration:

a. Set the IP Address and Subnet Mask according to the READY IPC you have:
= Forge/Ctrl: set the IP Address to 172.16.255.251 and set the Subnet Mask to 255.255.255.0.
= Forge/Hub: set the IP Address to 192.168.1.20 and set the Subnet Mask to 255.255.255.0.

b. Select a Control Device of Remote I/0. This allows your robot to run through a READY pendant instead of
through a Windows PC.

c. Click Apply.

5. In the Controller menu, select Preferences:
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a. Uncheck Virtual I/O to disable it.
b. Uncheck Auto safeguard position recovery to disable it.
c. Select Independent mode.
d. Select Enable background tasks.
e. Select Enable advanced task commands.
f. Click Apply.
6. In the Inputs/Outputs menu, select Fieldbus Slave. Select a Fieldbus Type of Modbus TCP. Click Apply.

7. In the TCP/IP menu, set the TCP/IP Ports to the values listed below. Use the same IP Address as earlier for each

port.
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a. Set Port 201 to 49152, enter the correct IP address, then Apply.
b. Set Port 202 to 49153, enter the correct IP address, then Apply.
c. Set Port 203 to 49154, enter the correct IP address, then Apply.
8. Click Close.
9. Open the Project tab. Click Properties.

10. In the Compiler menu, expand the Compiler Version dropdown. Select 7.5.2.x (or later).
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11. Click Apply, then Close out of the pop-up.



Chapter 11. Building the Driver

It's time to build the driver. This step sends the program files to the robot.

1. In the top menu bar, open the Project dropdown. Click Build.

2. If you see the prompt below, select Yes to overwrite the project on the controller.

ﬁ EPSON RC+ 7.3.0 - Project C:\EpsonRC70\Projects\EPSON_DRIVER - O et

File Edit View Projecl Run Tools Selup Window Help
D @& & @ pE == 120 5 0]#E & & 78 % F @ 0o Connection: USB 2

Project Explorer X
1423 Program Files ~
lib_arm_ral.prg

lib_am_robat prg

--{E] lib_am_ser_cbor.
i EPSOM RC+ 7.0

lib_amays prg
lib_commands prg
lib_functions.prg .
lib_aueve prg 0 Warning:
lib_ral.prg Project in controller is 'EPSOM_DRIVER'. This is not the same

lib_robat prg as current PC project.
lib_robot_functions prg
lib_ser_cbor.prg
~[E] main prg Continue?
--{EZ] main_meotion prg
main_state.prg
main_system prg
motion_master prg
mation_maotion_circular prg
mation_motion_jog pra

-~[E) motion_motion_joint.prg

The project in the controller will be overwritten.

motion_motion_linear prg

mation_motion_pause_resu

-[E] mation motion setscals o Y
>

<
Status nXx
16:14:08 Linking -~
v
< 2>
Program | EStop Safety | Error Warning Rebet: 1, VTGAI01S, VTE-A901S | No Tasks Running

3. Check that you have a successful build by looking for a "Build complete, no errors" message in the Status

window.
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Status

15:32:26 Sending tests_language_strings_test_strings.prg
16:32:26 Sending tests_language_strings_test_string_ascii.prg
15:32:26 Sending tests_language_strings_test_string_compare.prg
16:32:26 Sending tests_language_strings_test_string_concat.prg
15:32:27 Sending tests_language_strings_test_string_operations.prg
16:32:27 Sending lib_ral.prg

15:32:27 Sending lib_ser_chor.prg

16:32:27 Sending systerm_state_allcormmands.prg

15:32:27 Sending lib_arr_ser_chor.prg

16:32:27 Sending lib_arr_ral prg

15:32:28 Sending lib_arr_robot prg

15:32:28 Sending lib_gueue.prg

156:32:28 Sending robotl pts

15:32:28 Sending EFPS0MN_DRMNER.spr

15:32:28 Sending EPSON_DRMWER.ohj

15:32:29 Sending |OLabels.dat

15:32:29 Sending UserErrars dat

15:32:29 Sending EFS0OMN_DRINER. vis

15:32:29 Sending EPSON_DRMER g

15:32:29 Loading projectin controller...

15:32:30 Build complete, no errars

6 Tip:

If you see build errors, refer to




Chapter 12. Starting the Driver

1. In the top menu bar, open the Run dropdown. Click Run Window.

2. To start the driver in Remote I1/O mode, click Enable Remote 1/0O.
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3. In the pop-up below, click Yes to start BGMain.



Chapter 13. Device Configuration - Pt.2

In these steps, you save the robot in the Device Configuration app and finish the setup.

1. Finish entering your EPSON device information.
a. Give your device a name.
b. If you are using the READY-made Forge/Ctrl, enter the IP Address 172.16.255.251. If you are using the

READY-made Forge/Hub, enter the IP Address 192.168.1.20. If the IP address you assigned to the robot is
different, enter that.

2. In Forge/OS, confirm your device settings and tap SAVE. Forge/OS attempts to connect with the robot controller for
up to 20 seconds.

Note:

When you first connect to a robot, it's normal to see some robot errors and/or warnings on the

READY pendant. Ignore these for now. You will clear them after you finish adding the robot to Forge/OS.
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a. If the robot controller fails to connect, you see this pop-up.

Click DISMISS, do the following, then try to tap SAVE again:
= Check the Ethernet connection between the robot controller and IPC.
= Check the network settings on the robot controller.
= Check if the robot controller is on and in the correct operating mode (in auto or remote mode).
= Select the correct robot controller and robot models in Device Configuration.

3. When the robot connects, you can add Tool Center Points (TCPs) or Payloads for the robot. You can come back to

this later by editing the device's configuration. Tap SAVE to continue.

Note:

The default TCP is at the robot's tool flange. The default Payload is zero.

4. (Optional): Set up the robot controller's Input/Output (I0) signals for use in the Device Control Panel and Task

Canvas.
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a. Enter a Display Name (i.e. "Open Machine Door", "Open Pneumatic Vise", or "Start Machining Cycle") to

show what each signal does in other apps.
b. If you want a signal to appear in the Device Control Panel, check the DCP box next to that signal.

Note:

To use these 1/O signals, integrate your I/O devices with the robot controller.

c. Tap SAVE. Forge/OS returns to the Configured Devices list, which shows the new robot as enabled.

Note:

A device is enabled when its switch is green and toggled to the right.

5. Follow these steps to clear robot errors:
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a. Tap the Device Status button on the Toolbar to expand the Device Status Panel. The robot is listed with two
buttons: MORE and RESET.

b. Tap RESET to try to recover from the errors. If you can't RESET an error, tap MORE to get more details and

instructions.

Congratulations! You are ready to control your robot in the Device Control Panel and Task Canvas apps.



Chapter 14. Closing RC+

You can now control the robot arm with just the READY pendant. Follow these steps to disconnect your PC from RC+.

1. Unplug the USB cable from your Windows PC and robot controller. A "Communication disconnection detected"
pop-up appears in RC+.

2. Check the READY pendant for errors, such as the "Communication Disconnection Between RC+ and Controller"
error. Follow these substeps to resolve it:

a. Tap the Device Status button on the Toolbar to expand the Device Status Panel. The robot is listed with two
buttons: MORE and RESET.

b. Tap RESET to try to recover from the error. If you can't RESET the error, tap MORE to get more details and

instructions.



Chapter 15. Appendix A: Setting Up Forge/OS

Installing ForgeOS

Follow these steps to install ForgeOS and sign in to the Admin role. Installation takes about 30 minutes, depending on the

resources of the IPC.

1. To install ForgeOS, follow these substeps. You need a ForgeOS installation USB flash drive. Contact your READY

Robotics distributor for an installation USB drive.

! Important:

Installing ForgeOS will erase all data on the target hard drive.

a. Connect a monitor, keyboard, and mouse to the IPC where you want to install ForgeOS.

b. Plug the ForgeOS installation USB flash drive into the IPC.

6 Tip:

If you need more USB ports, use a USB 3.0 hub.

c. Restart the IPC. While the IPC is powering on, press the keyboard hotkey that takes you to the Boot Menu.

Note:

password. Contact READY Support if you run into this issue.

e ™
0 Tip:
The key that opens the Boot Menu depends on the IPC model. The most common keys that do this
are ESC, F10, F11, or F12. Refer to your computer's documentation for boot options.
N J
e ™

If you're installing Forge/OS on a Forge/Ctrl, press F11. You may need to enter the BIOS Admin
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d. From the boot options, select Install ForgeOS to boot from the installation USB flash drive.
e. The installer may take several minutes to load. Wait until the installation wizard opens.

f. Select your language. Then click Install Forge.

g. Choose a keyboard layout. Then click Continue.

h. Select Minimal installation. Uncheck Download updates while installing forgeos. Then click Continue.
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i. Select Erase disk and install forgeos. Then click Continue.

Note:
If ForgeOS is already installed, the installation wizard will show additional options. The goal is to
erase the entire disk for a brand new installation.

j- Select the IPC hard drive for ForgeOS and click Install Now.
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k. Confirm that you want to erase the entire disk by clicking Continue.

I. Make a note of the pendant instructions. If you're using a Forge/Ctrl, select the checkbox next to This
hardware is a Forge CTRL.

m. Choose your timezone. Then click Continue.
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n. Choose your IPC's host name. The host name identifies the IPC on the network. Pick a username and

password. Then click Continue.

Note:
The username and password that you create here are for accessing the IPC desktop. They are NOT
for signing into ForgeOS on the READY pendant.

0. Wait for the installer to copy and install ForgeOS.
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p. Once the installation completes, click Restart Now.

g. When prompted, remove the installation flash drive. Then reboot.

Please remove the installation medium, then reboot.

r. Wait for ForgeOS to finish booting.
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s. When you see the login screen with the ForgeOS 5 logo, ForgeOS is ready to run on the READY pendant!
You don't need to sign in to the desktop. Disconnect the monitor, keyboard, and mouse that you used to
install ForgeOS.

2. The READY pendant automatically finds and pairs with the IPC. The three LEDs on the screen help you track the
status:
- Pendant Network Connection: This condition is satisfied when the READY pendant has a valid network
connection (i.e., the Ethernet cable is plugged in).

> ForgeOS IPC Detected: This condition is satisfied when the READY pendant detects a Forge/OS IPC on

the network.
> ForgeOS IPC Paired: This condition is satisfied when the READY pendant successfully pairs with the IPC. If
pairing fails, it is automatically retried indefinitely.

When a condition is not satisfied, the LED is red. When a condition is in progress of becoming satisfied, a spinner

around a READY logo appears to the right of the text. When a condition becomes satisfied, the LED turns green.
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The Ul shows the real-time state of each step. For example, if the pendant loses its network connection

during pairing, all steps become undone. If the READY pendant spends more than 60 seconds on any step,
troubleshooting text displays. Common things to check are if the READY pendant network cable is plugged in, if
the IPC is powered on, if the READY pendant and IPC are connected to the same network, and if there’s only one
READY pendant and one IPC on that network.

3. Tap Admin and sign in. The default Admin password is "forgeadmin".

Note:
After installation, you have limited access to ForgeOS until you activate it with a license code. See Activating
ForgeOS with a License Code (on page 51).

Activating ForgeOS with a License Code

There are two methods to activate ForgeOS: Online license activation and offline license activation.

The table below lists the requirements for each method.
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Online License Activation

Offline License Activation

* An internet-connected ForgeOS
« A valid ForgeOS license code

* A 2GB or larger USB flash drive
» An internet-connected PC

+ A valid ForgeOS license code

N

-
0 Tip:

Connect a USB keyboard to the port on the bottom of the READY pendant to type in any text field in ForgeOS.

1. On the Settings app main screen, tap License.

2. Type in your license code.

3. Choose ONLINE LICENSE ACTIVATION if ForgeOS is connected to the internet. If not, choose OFFLINE

LICENSE ACTIVATION.
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4. If you chose online license activation, you're done!
5. If you chose offline license activation, follow these substeps:

a. Insert the USB flash drive into your IPC. Tap START WRITING CERTIFICATE TO USB DRIVE.

b. When the files finish transferring, tap NEXT. Follow the instructions on the screen to convert the Activation

Certificate to an Unlock Certificate using an internet-connected PC.
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c. Insert the USB flash drive back into your IPC. Tap UNLOAD UNLOCK CERTIFICATE FROM USB DRIVE.

d. Wait for the file to finish transferring. When the file transfer is complete, remove the USB flash drive and tap
SAVE.

e. ForgeOS returns to the licensing home screen and shows an active license. If the license status isn't active,
restart these license activation steps. Double-check your license code.

Choosing Preferences

These steps help you choose system preferences, including language, units, time, and network settings.

To change preferences for the first time, go to General Settings:
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a. On the Settings app main screen, tap General Settings.
b. Change the Units of Measure, Time and Date settings, or the Admin login password.

Note:

If you later forget your password, contact READY Robotics to reset it.

c. Tap SAVE to save changes and exit the General Settings menu.



Chapter 16. Appendix B: Known Issues

You may encounter programming issues when the EPSON robot comes near a singularity. THESE ISSUES ARE NATIVE
TO EPSON AND ARE NOT CAUSED BY FORGE/OS.

What is a singularity? A singularity is a position that prevents a robot from making certain movements. A singularity can

occur when two or more joint axes are co-linear, such as the axes of Joint 4 and Joint 6.

In a singularity, a robot cannot reach a specified waypoint due to physical limitations. This doesn't mean that it can't reach

the waypoint, but it is unable to move to the position in that way.

! Important:
When you move a robot near a singularity, the robot may move unexpectedly, speed up, or enter an error state.

Two behaviors you may see near a singularity are excess jogging and rejected stop requests.

Excess Jogging At a Singularity

When you jog the robot near a singularity, the robot may move for an extra 1-2 seconds after letting go of the jog button.

This issue is the common with linear jogs on EPSON robots. Linear jogs move the robot's tool center point (TCP) in the

Cartesian space (X, Y, Z, Rx, Ry, Rz). Use joint moves around singularities.

When jogging the robot near objects, use a low speed to avoid unpredictable collisions.
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Stop Requests Rejected by the Robot

When the robot is moving through a singularity, it might not immediately stop with the READY pendant Stop button or with
an external safety device (such as a light curtain or a safety fence). However, the robot will always immediately stop with
the E-Stop.

! Important:

In emergency situations, ALWAYS hit an emergency stop button that is wired to the emergency stop circuit of the
EPSON controller.

For example, if you execute a circle move that has an arc point near a singularity, the robot might finish its entire path of
programmed motion regardless of any stop signal it receives (other than the E-Stop).

To minimize risk, use a low speed as you first build out your task. This will help avoid unpredictable collisions.



Chapter 17. Appendix C: Troubleshooting

Use this section to recover from an unresponsive robot or from build errors.

Driver Kill Switch for Unresponsive Robot

If a port fails to configure when you load the driver, you may lose all connection to the robot when you reboot.

To shut down an unresponsive driver, set 1023 (pin 27) to HIGH by making these connections:

+ OV to Pin 14 (Input common)
* 24V to Pin 27 (Input No. 23)

6 Tip:

To check if 1023 is set to HIGH, open the I/0 Monitor from the Tools menu. In the pop-up, select All Inputs.
Check if there's a red dot next to input 23.

While 1023 is set to HIGH, restart the robot. This setting prevents the driver from launching when the robot powers up,
allowing you to reconfigure the robot. The Runtime Controls window reads "Kill switch enabled, disable to start driver" until
you set 1023 back to LOW (turning the red dot off).
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Initial Device Configuration Error

When you set up your robot for the first time, you may see build errors.

Try deleting and re-adding the robot in System Configuration.
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1. In the top menu bar, select Setup. Go into System Configuration.

2. Expand the Controller menu. Open Robot 1. Note what the settings of the configured robot are. If they don't
match your robot model, make a note of that.

3. Click Delete and Yes to re-configure the Robot 1 file.

4. Click Add. Enter the robot's information. Then click OK.
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5. Close out of the System Configuration menu.

6. Rebuild the project (as outlined in the next section).

Rebuilding the Source Code

You need to rebuild the source code:

« after you resolve a build error.
« if the Epson encounters a stack error in the Epson logs while you are running a task. When this happens, you will
receive a Forge/OS message asking you to rebuild.



EPSON VT6L Startup Guide | 17 - Appendix C: Troubleshooting | 62

1. In the top menu bar, open the Project dropdown. Click Rebuild.

2. If you see the prompt below, select Yes to overwrite the project on the controller.

@ EPSOM RC+ 7.5.0 - Project C:\EpsonRCT70\Projects\EPSON_DRIVER - m} X
File Edit \iew Project Run Tools Setup Window Help
D@ & & B@ @ I @ [ 5] 2 ok B 2 % =] @ | o= Comection: USE

(=24 Program Files
lib_am_ral prg
lib_am_robot.prg
lib_am_ser_cbarprg
lib_arrays prg
lib_commands prg
lib_functions prg

EPSON RC+ 7.0

‘Warning:

lib_gueue prg
li_ral.prg Project in controller is ‘EPSON_DRIVER', This is not the same
lib_robot prg as current PC project.

lib_robot_functions prg
lib_ser_cbor prg
main prg
main_motion.prg
main_state prg
--{E2] main_system pra
motion_master prg
mation_mation_gircular prg
maotion_motion_jog prg
mation_motion_joint prg
mation_mation_linear prg
mation_motion_pause_resu

[E] mation matinn setseals ne
>

The project in the controller will be overwritten.

Continue?

[l w

]

15:14:09 Linking...

< >
Program | EStop Safety | Error \Warning Robot: 1. VT6A3015. VT6-A9015 | No Tasks Running

3. Verify that you have a successful rebuild by looking for "Build complete, no errors"” in the Status window.
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Status

15:32:26 Sending tests_language_strings_test_strings.prg
16:32:26 Sending tests_language_strings_test_string_ascii.prg
15:32:26 Sending tests_language_strings_test_string_compare.prg
16:32:26 Sending tests_language_strings_test_string_concat.prg
15:32:27 Sending tests_language_strings_test_string_operations.prg
16:32:27 Sending lib_ral.prg

15:32:27 Sending lib_ser_chor.prg

16:32:27 Sending systerm_state_allcormmands.prg

15:32:27 Sending lib_arr_ser_chor.prg

16:32:27 Sending lib_arr_ral prg

15:32:28 Sending lib_arr_robot prg

15:32:28 Sending lib_gueue.prg

156:32:28 Sending robotl pts

15:32:28 Sending EFPS0MN_DRMNER.spr

15:32:28 Sending EPSON_DRMWER.ohj

15:32:29 Sending |OLabels.dat

15:32:29 Sending UserErrars dat

15:32:29 Sending EFS0OMN_DRINER. vis

15:32:29 Sending EPSON_DRMER g

15:32:29 Loading projectin controller...

15:32:30 Build complete, no errars

4. Start the updated driver. Navigate to the top menu bar, open the Run dropdown, and click Run Window.
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5. To start the driver in Remote I/O mode, click the Enable Remote 1/O button. Click Yes in the pop-up window.

Digital Output Configured as System Output Error

You may see a "Digital Output Configured as System Output" error in Forge/OS or an "Error 2342: Cannot change

the status for output bit configured as remote output” in RC+.

For example, suppose you have Output O linked to the "Ready" signal. In the I/O Monitor, output bit #0 has the label
"Ready". On the READY Pendant, if you select the DCP checkbox next to Output 0 in the robot's device configuration and
then try to change the state of Output 0 in the robot's Signals tab in the Device Controls app, you will get an error.

Follow these steps to unlink Output 0 (or other outputs) in RC+.
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1. In the top menu bar, click Setup. Go into System Configuration.

2. In the Controller menu, select Remote Control and then Outputs.

System Configuration ? x
& Startup Remote Control Outputs o
(- Controller

- General
- Configuration
-~ Preferences Output Signal Qutput ~
- Simulator 0
[#-Drive Units : :
[#- Robots Running 1
[#- Inputs / Outputs Paused 2
= F!_emclte Contral Error 3 Defaults
EStopOn 4 o
SafeguardOn 5 =
SError 6 Save
‘wiarning 7 —
#-RS232 MotorsOn Met used
- TCP /1P AtHome Mot used w
[+ Security
- Vision

3. Configure the output signals to an output bit (or select "Not used").

Note:

You cannot select Output #8 or #9. These outputs are reserved by Forge/OS.




Chapter 18. Appendix D: Error Recovery

Some errors are not recoverable from Forge/OS. One such error is Error 4066: "Motion Command was attempted in the

prohibited area depended on joint combination." This error occurs when you move the robot outside of its joint limits.

In these situations, the robot is not movable in Forge/OS or in the EPSON RC+ Robot Manager. In this case, use the
instructions below to recover your robot to an operable state.

1. Restart RC+ by closing out of it and re-opening it in Program Mode.
2. If necessary, reload your project:

a. In the top menu bar, open the Project dropdown.
b. Expand the Recent Projects menu.
c. Select the EPSON_DRIVER file.
3. If you see a pop-up asking if you want to disconnect from the controller, click No.

4. In the top menu, go to the Tools menu. Open the Command Window.
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5. Turn motors off.

a. In the Command Window, type “Motor Off”, then hit Enter.

» Motor Off
=

6. Turn a joint brake off.
a. Check which joint is out of the movable zone or in a state that it cannot move.

b. In the Command Window, type "Brake Off, [JOINT#]", then hit Enter. For example, to release the joint 3
brake:

. M
Note:
Depending on which joint that you are releasing the brake for and what position that joint is in, you

may need to catch the robot as it falls. Avoid damage to the robot and any nearby objects that it

might collide with.

> Brake Off, 3
>

7. Move the joint and turn its brake back on.
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a. Use your hands to move the joint back within the movable zone.

b. In the Command Window, type "Brake On, [JOINT#]", then hit Enter.

» Brake Off, 3
> Brake On, 3
=

8. Turn motors on.

a. In the Command Window, type "Motor On", then hit Enter.

> Motor Om
> |

9. Restart the driver in Auto Mode.



Chapter 19. Contacting READY

Visit READY.academy for FREE hands-on courses to help you deploy a robotic system.
Visit our Support site for robot startup guides, FAQs, and more.

If you encounter a problem and need to talk to someone, reach out to us.

« Email READY Robotics: support@ready-robotics.com
« Call READY Robotics: +1-833-732-3977



https://ready-robotics.com
https://https://www.ready-robotics.com/support/support-home
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